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INTRODUCTION

m  What is SPSS?

- Statistical software for analysis commonly used by
Social Scientists

m Why SPSS?
- One of the easier statistical tools to maneuver

through
] Programming languages don’t have drag & drop or a . ; -
navigation bar! 3 A & [ e == =» He QA
g output M Close R
- Valuable technical skill for institutions / companies o < g T T T
EL=l H EFE .iole | QA
. Key Ta keaways On SPSS: ?ivP::rlt(ongvl::azugnly Visible: 0 of 0 Variables
- Importing data Bl
Display Data File Information
-  Prep data 2 S
- Running basic statistics S —

& Print...

Welcome Dialog...
Recently Used Data
Recently Used Files

(Data View | Variable View

IBM SPSS Statistics Processor is ready ¢ Unicode:ON




Importing data from Qualtrics into SPSS

Survey Actions Distributions Data & Analysis Reports

data Text Crosstabs Weighting
Recorded Responses 199

Add Filter v
Responses in Progress 0

Go to your project on Qualtrics
. Data & AnaIySIS Page1of10 v > Since

i S Edit H 2 Tools v

Q56 - What type of Im| ]
R port Data...
° EX p 9) rt D ata organization is Q1e0-whatdidyou Qoo ML qrga - what " | £l poun ot
0 Recorded this? (e.g. find most questions? If you class of Dr. d;s (@ Response Export Automation... .ter . Actions
Date Cgmmunltx |nter‘est|ng/|nforma'(|ve EREESEE C's ére you o (@ Response Import Automation... E.
service, special at Discoverfest 2019? I —— in? Jent
interes... Manage Previous Downloads... iy -
e

Data & Analysis

Download a data table Use the legacy exporter

DOWn Ioa d I ng th e d ata I Csv | TSV \ Excel | XML ﬂ Google Drive User-submitted files
[ CO m m O n to use CSV’ b ut We Statistical Analysis Package PBort & imp
will opt for SPSS since that's .

Statistical Package for the Social Sciences (SPSS) is one of the most
* widely used software packages for survey analysis. This is an SPSS sav

data file with raw data, variable and value labels.

Learn more

the software we’ll be using et g
C SPSS > Download ::T'::;zal ] Download all fields

teres...

More options Close ' Download




Opening Datasets in SPSS

[ JeX ) Welcome to IBM SPSS Statistics

New Files: What's New: | 1. Choose flle under

o New Dataset
(&9 New Database Query... ¥

» “Recent Files” or “Open

o PRINT {X; POF_X;COF_X}. |
Recent Files: END MATRIX.

- Cal State Fullerton/missvaldataex.xlsx | a n Oth er fi I e amm "

a /Users/marrionmac/OneDri .
8= /Users/marrionmac/OneDrive - Cal State Fullerton/datamergex1.xIsx Matrix 1

&= /Users/marrionmac/OneDrive - Cal State Fullerton/datamergex.xIsx Bun MATRIX procedure: 1
. \ii% .../OneDrive - Cal State Fullerton/stepwiseregexample.spv | POF_XCDF X} >
LO00000000  1.000000000  2.000000000  1.000000000 4. 5. oddeeddee E
Open another file... L031250000  .156250000 312500000  .312500000 156250000 031250000
031250000 187500000 500000000 JB12500000 J96ETS0000  1.000000000

e | 2. 0Open

Random variable generation and distribution function
evaluation functionality within the MATRIX procedure now
matches that available in COMPUTE.

B &) |

Help & Support Tutorials mmuni
w Sample Files Visit SPSS Statistics page to explore Give Feedback | |
available packages and offers.
Eopen Report Issue E

2.

Don't show this dialog in the future Close




Qualtrics Data into SPSS

Data View Variable View

® @ prepsurvey2.sav [Dataset3] - IBM SPSS Statistics Data Editor o ( ] (& prepsurvey2.sav [DataSet3] - IBM SPSS Statistics Data Edifor
—. ( H = B I_Q] IDi];‘,sl;; -~ E%%@ aﬁ @:E % (@ H Q
H |— l‘ L,_,] g e E&%@ Bﬁ E L‘.Hf H Q 7 e = : = : e md @
Ve 750 o 58 Vel Name Ty.pe Width Decimals Label Values Missing Columns _ .Align Measure

1 Q33 Numeric 40 0 Who can I talk t... {4, agree}... None 6 Right & Scale

£33 Faisz | L3511 P52 FQ353 P Q354355 £ 0356 F Q357 Q358 ¢ Q359 2 Q152 Numeric 40 0 What class of D... {1, T/TH me... None 8 Right & scale

1 4 1 3 Q35_1 Numeric 40 0 Which of the fol...|{1, First gen... /None 8 = Right .f Scale

2 4 2 1 1 4 Q35_2 Numeric 40 0 Which of the fol...|{1, Second g...|None 7 = Right f Scale

3 4 1 1 1 5 Q35_3 Numeric 40 0 Which of the fol...| {1, Commuti...| None 7 Right f Scale

4 5 1 1 6 Q35_4 Numeric 40 0 Which of the fol...|{1, Commuti... None 7 Right & scale

5 4 1 1 1 7 Q35_5 Numeric 40 0 Which of the fol...| {1, Commuti... None 7 Right & Scale

6 4 1 1 1 1 8 Q35_6 Numeric 40 0 Which of the fol... {1, Commuti... None 7 Right & scale

7 4 1 1 9 Q35_7 Numeric 40 0 Which of the fol... {1, Recruite... |/None 7 Right &) Scale

8 4 1 1 1 10 Q35_8 Numeric 40 0 Which of the fol... {1, Internati... None 7 Right & Scale

9 4 2 11 Q35_9 Numeric 40 0 Which of the fol...|{1, Receivin... |None 9 Right f Scale

10 4 2 1 12 Q35_10 Numeric 40 0 Which of the fol...|{1, Coming ... None 8 = Right & Scale

11 4 L ! 13 Q35_11 Numeric 40 0 Which of the fol...|{1, Transfer ... None 8 = Right & Scale

2 4 ! ! ! ! 14 Q35_12 Numeric 40 0 Which of the fol...|{1, Transfer ... None 5 = Right .& Scale

UBataNiewy Variable View Data View | NafiableNiewy
IBM SPSS Statistics Processor is ready 4 Unicode:ON IBM SPSS Statistics Processor is ready Unicode:ON

Wow so easy....




Prepping data in SPSS

* Recode missing values
e Specifying “Measure”

* Merging data




Prepping data in SPSS: Missing Values for Binary Questions

Need to account for missing values so our analysis is accurate

3. If you checked “yes”, please state what

other language(s) you can speak: (Mark all that

Q3 1|:]ls - ¢ SPSS assumes that the participant
3_ panis . o
Q3.2 O Vietnamese 1 = marked did not answer the question (hence,

03 3 O Chinese . .
Q3 4 O Korean mISSIHg): Statistics

Q3 5 O Other: if
- . you If you If you If you If you
Q3_5_TEXT string checked checked checked checked checked
"yes", please "yes", please "yes", please "yes", please "yes", please
stat what stat what stat what stat what stat what
other other other other other
language(s) language(s) language(s) language(s) language(s)
Example dataset - you can you can you can you can you can
speak:(Mark speak:(Mark speak:(Mark speak:(Mark speak:(Mark
® ( ] ) exampledata.sav [DataSet1] - IBM SPSS Statistics Data Editor a;lll)rzit) aglyljlt:;lt) aggltgit) aglll)lt:‘:t) aglrlalt:it)
- . ] : ] - ies.): ies.): ies.): ies.): ies.):
H =1 | [_2_] ’E\”/ “eke K E % %C@ aﬁ % ﬂ : l@ @ | ‘ O\ Spanish Vietnamese Chinese Korean Other - Text
13: Visible: 11 of 11 Variables N Valid 3 1 0 0
@a QL Q2 | Q31| g2 | w3 g4 a Q3_5_TEXT b4 &4 Q5_1_TEXT $hQs 1 | §hQs Missing 2 4 5 0
1 007 1.00 1.00 . 4.00/3.61 . 1.00 - 1.0000 1.0000
2 008 1.00 . 1.00 . . 5.00/3.21 . 1.00 o
R 009 ol _ M = S_ A _ “o0l278 : 100 Std. Deviation .00000
4 010 1.00 1.00 ISSI g ) 5.00/3.40 . 1.00
5 011 1.00 1.00 data for Q3 4.00[3.10 . 1.00

(uBataViewy| Variable View

IBM SPSS Statistics Processor is ready Unicode:ON




Prepping data in SPSS: Missing Values for Binary Questions

Transform > Recode into Same Variables The New Value will be O
400 4 [ JOX ) Recode into Same Variables: Old and flew Values
| NON Recode into Same Variables 3 | Old value New Value
Numeric Variables: 3 Value: O value: 0
| | &4 Please provide you... &5 If you checked "yes", please stat ... 5 | System-missing
| | &5 Do you speak a la... &5 If you checked "yes", please stat ... | 20 System-missing Old > New:
| é& If you checked "yes... ¢f. If you checked "yes", please stat ... 3 System- or user-missing W3
&5 How likely are you ... + & If you checked "yes", please stat ... Range:
| | &5 What is your curre... I | Add
| | &5 What is your curre... ; | | through Change
| | &5 Do you intent to ap... | | e
m | | Range, LOWEST through value:
If... (optional case selection condition)
Range, value through HIGHEST:
? Reset Paste Cancel OK
All other values
! l l ? Cancel | Continue
PO @ exampledata.sav [DataS
SHS M e~ & =
SHE B -~ B 1 B
‘J#L:——'.]gé[— - ~&% L
Data set with recoded missing 7:Q3.4
variables: $aQl | R  $B1 | $B2 | $®B3 | Ha4
5 . 1 007 1.00 1.00 .00 .00 .00
Elther O Or 1’ they elther 2 008 1.00 .00 1.00 .00 .00
speak the language (1) or 3 009 00 00 00 00 00
4 010 1.00 1.00 .00 .00 .00

they don’t (O)

5 011 1.00 1.00 .00 .00 .00




7

Prepping data in SPSS: Missing Values for Text Responses

Example: Q3_5 TEXT

Name Type Width Decimals Label
Q3_5_TEXT |String 8 0 If you checked "yes", please stat what other language(s) you can speak:(Mark all that applies.): Other - Text
® O Missing Values

No missing values
© Discrete missing values

-9

Range plus one optional discrete missing value

Low: High:

Discrete value:

? Cancel = S

Click the “...” in under the Missing column

For missing text responses, we
traditionally use -9 at C-REAL

Values

None

Missing
None

(

1



Prepping data: Adjusting our “Measure” column

1. Please provide your student 4. How likely are you to go to college? (Mark

I
. Q1 1D.: strin LD,
Nominal ﬁ . Q4

O Extremely unlikely 1

The 3 options are Scale, Ordinal, and Nominal: Z g epeslc o language ofher than O Unlikely 2 Ordinal
Q2
Scale: values represent ordered Nominal qL 0 Yes L D Neutral :
categories with a meaningful metric, so o ey :
. o . R | —— O Extremely likely 5
that distance comparisons between o anguge(e) S Con spcal (Mark al tht
. aoohes) ’ - 5. What is your current GPA for this semester?
values are appropriate Lo a5 1To numeric - e Scale
. _ panis 0
Examp|e: score of a student in SAT gg_; S \C/iftna@ese 1 = marked Q5_1 O 1do not know
exam gg:: g g(’}:can 6. Do you intend to apply to college? Nominal
H . o ther:
Ordinal: values represent categories with Q3.5 TEXT ___ string @0 Ye |
ranking vw._/
Example: 1=Highly satisfied, Nominal ns  Align Measure Role
L = Left &5 Nominal ™ Input
2=satisfied, 3= neutral, 4= =ront @ Nominal | Input
dissatisfied, 5= highly dissatisfied =Right | Nominal | mput
Nominal: values represent categories with W ooht (dbNominal | input
. = Right @5 Nominal “ Input
no ranking R S N
Example: zip code or gender Sttt N Input
= Right @ Nominal i " Input
= Right &5 Nominal ™ Input
= Right &5 Nominal ™ Input

Right &5 Nominal “ Input




Prepping data: Merging

 Combining pre/post test data  Want to combine datasets

® lang2ex.sav [DataSet2] - IBM SPSS Statistics Data Editor

[ J
/= =i O =
& D &5 Attendance & Score_posttest & Score_pretest = uﬁ (=) LI % % %‘ % EH; % j K

1 9975309 0 53 48 Q
2 9948278 1 80 75
9169427 4 95 %0 Visible: 4 of 4 Variables
3 & D “3 Language @‘9 Examl &_ Yrs_in_progr
4 8643086 3 95 90 Sa—o
1 710080 2 90 2
5 7988957 1 79 72 2 991442 2 78 2
6 7509550 1 67 61 - 3 717816 2 4 !
4 69519 2 56 1
7 6133087 2 91 86 s 606943 2 78 3
8 6115282 2 89 84 6 15953 2 89 1
9 5396215 2 86 81 Z 841815 2 % 3
8 4510 2 72 2
10 4365151 3 88 83 5 43971 > o P
11 4303020 1 83 78 10 22883 2 87 3
11 720712 1 90 3
12 3670778 1 63 56
12 112443 1 88 2
13 3316521 0 57 54 13 436183 1 78 1
14 3168177 0 67 66 14 464671 ! 45 !
15 500578 1 65 1
15 2331702 1 61 56 = 88588 1 78 1
16 1767276 0 51 46 17 846822 1 91 3
17 1328727 1 71 65 L5 152498 ! & 2
19 429405 1 63 1
18 1323956 3 93 88 20 419648 1 81 3
19 926172 0 50 48
20 661007 2 85 79 | |

(DBataViewy Variable View




Prepping data: Merging different datasets

1. Have both datasets Open [ ] ® (&8 lang2ex.sav [DataSet2] - IBM SPSS Statisticil)ata Editor
= OP= . =] 1= B HESE|SHE ~ B HE
2. Make sure matching variables have the same settings == = " ) ﬁé%‘ FHEE (| SEs S E&%‘ FHEE .

under “Variable View” O\ O\

Visible: 4 of 4 Variables Visible: 4 of 4 Variables
-~ & D &> Language & Exam1 o Yrs_in_progr & D & Language & Exam1 & Yrs_in_progr
@ am — am
Name Type Width Decimals Label

Name Type Width Decimals ! 1 720712 1 90 3 1 710080 2 90 2
1 D Numeric 18 0 !

1 D Numeric 18 o 2 112443 1 88 2 2 991442 2 78 2
2 Language Numeric 1 0 1

2 Language Numeric 1 0 3 436183 1 78 1 3 717816 2 45 1
5} Examl Numeric 2 0 !

3 Examl Numeric 2 0 4 464671 1 45 1 4 69519 2 56 1
4 Yrs_in_prog... Numeric 1 0 1

4 Yrs_in_prog... Numeric 1 0 5 500578 1 65 1 5) 606943 2 78 2

6 588588 1 78 1 6 15953 2 89 1

7 846822 1 91 3 7 841815 2 98 3

8 152498 1 79 2 8 4510 2 72 2

9 429405 1 63 1 9 543971 2 84 2

10 419648 1 81 3 10 22883 2 87 3




Prepping data: Merging different datasets

Data > Merge > Add Cases

[ NON ) Add Cases From DataSet1
® ® Add Cases to lang2ex.sav[DataSet2] Unpaired Variables: \I/;rlables in New Active Dataset:
Select a dataset from the list of open datasets or from a file to merge with the active dataset Language
Exam1l
An open dataset
A +
langlex.sav[DataSet1] |
Pair
An external SPSS Statistics data file
Browse... Indicate case source as variable:
Non-SPSS Statistics data files must be opened in SPSS Statistics before they can be used as part of a merge Rename... source0l
? Cancel . Continue | . (*)=Active dataset
| (+)=DataSet1
? Reset Paste Cancel



Prepping data: Merging different datasets

After:

[ JON ) 4 lang2ex.sav [DataSet2] - IBM SPSS Statistics Data Editor

Before: SHEeE M e~ Bl N EFH

(&8 lang2ex.sav [DataSet2] - IBM SPSS Statistics Data Editor q

HE M-~ BB A EE | SHEE -~ Bl h BF .
Q

Visible: 4 of 4 Variables

o

& D & Language & Examl o Yrs_in_progr
- Lt am
1 710080 2 20 2
Visible: 4 of 4 Varlables: Visible: 4 of 4 Variables > 991442 5 78 2
&b &5 Language & Examl & Yrs_in_progr & D &> Language & Examl o Yrs_in_progr 3 717816 2 45 1
= an ® an 69519 2 6 1
1 720712 1 90 3 1 710080 2 %0 2 4 i 5
5 606943 2 78 2
2 112443 1 88 2 2 991442 2 78 2
6 15953 2 89 1
4361 1 7 1 717816 2 45 1
g 36183 8 2 7 841815 2 98 3
4 464671 1 45 1 4 69519 2 56 1 s 4510 5 2 ;
5 500578 1 65 1 5 606943 2 78 2 S 543971 2 aa 2
6 588588 1 78 1 6 15953 2 89 1 10 22883 2 87 3
7 846822 1 91 3 7 841815 2 98 3 1 720712 1 90 3
8 152498 1 79 2 8 4510 2 72 2 12 112443 1 88 2
9 429405 1 63 1 9 543971 2 84 2 13 436183 1 78 1
464671 1 45 1
10 419648 1 81 3 10 22883 2 87 3 L2
15 500578 1 65 1
16 588588 1 78 1
17 846822 1 91 3
18 152498 1 79 2
19 429405 1 63 1
20 419648 1 81 3

UDataViewy| Variable View




Prepping data: Merging pre/post test data

1. Have both datasets open vl
2. Make sure there’s an identification variable; variable we S ke

1 9975309 0 48 & D & Score_posttest
will use to match the two datasets together 2 9948278 1 75 1 9975309 53
- In this example, we have ID as the matching variable : a1eaaz7 ‘ % 2 9945278 80
4 8643086 3 90 3 9169427 95
5 7988957 1 72 4 8643086 95
6 7509550 1 61 5 7988957 79
7 6133087 2 86 6 7509550 67
8 6115282 2 84 7 6133087 91
9 5396215 2 81 8 6115282 89
10 4365151 3 83 9 5396215 86
11 4303020 1 78 10 4365151 88
12 3670778 1 56 11 4303020 83
13 3316521 0 54 12 3670778 63
14 3168177 0 66 13 3316521 57
15 2331702 1 56 14 3168177 67
16 1767276 0 46 15 2331702 61
17 1328727 1 65 16 1767276 51
18 1323956 3 88 17 1328727 71
19 926172 0 48 18 1323956 93
20 661007 2 79 19 926172 50
20 661007 85

Data View  Variable View

IBM SPSS Statistics Processor is ready *4 Unic( wBataView, Variable View
IBM SPSS Statistics Processor is ready #f Unicode:ON




Prepping data: Merging pre/post test data

[ JOX ) Add Variables from DataSet1

EEAVETEN Variables

Data > Merge Files > Add Variables

@ (] Add Variables to posttestdataex.sav[DataSet2]
Select a dataset from the list of open datasets or from a file to merge with the active dataset
© An open dataset One-to-one merge based on file order
pretestdataex.sav[DataSetl] © One-to-one merge based on key values

One-to-many merge based on key values

Select Lookup Table

isti i DataSet2*
An external SPSS Statistics data file
DataSet1
Browse...
Non-SPSS Statistics data files must be opened in SPSS Statistics before they can be used as part of a merge. *Active dataset

_ For a merge based on key values, files must be sorted in order of the
? Cancel Continue key values

Sort files by key values before merging

Key Variables:

-

@Use the Variables tab to add or remove key variables

? Reset Paste Cancel “




Prepping data: Merging pre/post test data

Before: After:

Visible: 4 of 4 V

[
Visil -
— - — §9 ID ¢;$9 Score_posttest éf, Attendance §9 Score_pretest
& D @ Attendance & Score_pretest Visible: 2 of 2
- 1 661007 85 2 79
1 9975309 0 48 &0 & Score_posttest
2 926172 50 0 48
2 9948278 1 75 1 9975309 53
3 9169427 4 90 2 9948278 80 3 1323956 93 3 88
4 8643086 3 90 3 9169427 95 4 1328727 71 1 65
5 7988957 1 72 P 8643086 95 5 1767276 51 0 46
6 7509550 1 61 5 7988957 79 6 2331702 61 1 56
7 6133087 2 86 6 7509550 67 7 3168177 67 0 66
6115282 2 84
g 7 6133087 ot 8 3316521 57 0 54
2 3396215 2 8 8 6115282 8 3670778 63 1 56
10 4365151 3 83 9 5396215 86 2
11 4303020 1 78 10 4365151 38 10 4303020 83 1 78
12 3670778 1 56 11 4303020 83 11 4365151 88 3 83
13 3316521 o 54 R 3670778 63 12 5396215 86 2 81
14 3168177 0 66 13 3316521 57 13 6115282 89 2 84
15 2331702 1 56 14 3168177 67 14 6133087 91 2 86
16 1767276 0 46 15 2331702 61 15 7509550 67 1 61
1328727 1 65
17 16 1767276 51 16 7988957 79 1 72
18 1323956 3 88 17 1328727 71
17 8643086 95 3 90
19 926172 0 48 18 1323956 93
20 661007 2 79 19 926172 0 18 9169427 95 4 90
= 661007 T 19 9948278 80 1 75
20 9975309 53 0 48

Data View  Variable View

IBM SPSS Statistics Processor is ready & Unic uBataView, Variable View

_ IBM SPSS Statistics Processor is ready Unicode:ON




IV: Descriptive Statistics

m A descriptive statistic is a summary statistic that quantitatively describes or
summarizes features from a collection of information

- lLe. Mean (commonly used as average), standard deviation, frequencies, etc..

m Some questions we can ask:
- What is the average GPA of our sample?
-  How much of the sample is Extremely likely to go to college?




Descriptive Statistics

Frequencies
* How many participants Example dataset:
speak a language other than —

English? FHE M -~ Bl M BE 10ld | QA

* How much of the sample is S ——
; @a QU oo Q2 eHQ1 | g5Q2 | HQB3 | B4 | $HQ5 | FHQ5TEXT @b Q| gh QLTEXT g5 Q5.1 @5 Q6
EXtremely ||ke|y to go t0 1 007 1.00 1.00 .00 .00 .00 .00 4.00 3.61 .00 3.00
2 008 1.00 .00 1.00 00 00 .00 5.00 321 00 4.00
(610) Il ege? 3 009 . .00 .00 00 00 .00 4.00 2.78 00 5.00
4 010 1.00 1.00 .00 00 00 .00 5.00 3.40 00 3.00
5 011 1.00 1.00 .00 00 00 .00 4.00 3.10 00 1.00
Descriptives

 What is the average GPA of
our sample?




Answering our questions: Frequencies

SPSS Statistics File Edit View Data Transform @ Analyze Graphs Utilities Extensions Window Help

Power Analysis

[ NON )
’%H%Eﬂd Reports

Descriptive Statistics
Bayesian Statistics

Analyze > Descriptive Statistics > B Tables
FrequenCieS &a Ql Q2 | g ai Compare Means

007 1.00 . General Linear Model
Generalized Linear Models
Mixed Models

Correlate

010 1.00 . Regression

* How many participants speak a Rear
. 011 1.00 1.00 oglinear
language other than English? g Neural Networks

Classify

* How much of the sample is Extremely Dimension Reduction

Scale

likely to go to college? Nonparametric Tests
Forecasting

Survival

Multiple Response

8 Missing Value Analysis...

Multiple Imputation

Complex Samples

iy Simulation...

Quality Control s Processor is ready | 4

_ Spatial and Temporal Modeling...
ire dIrKe l (]

Data Editor

Frequencies...
P3 Descriptives...
it Explore...

+ TURF Analysis
i3 Ratio...

7 P-P Plots...

7% Q-Q Plots...

4.00/3.10

vi | A W N
o
o
©o
o
(=

VYVVVVVVVVVVYVVVYVVYVYVY VY




Answering our questions: Frequencies (cont.)

« How many participants speak a language other than English? Statistics
* How much of the sample is Extremely likely to go to college? e

Percentile Values Central Tendency
Quartiles v Mean
Cut points for: 10 equal groups Median
Percentile(s): v Mode
Add Sum
Change
Remove
| O @ FrequenCIes Values are group midpoints
. Dispersion Distribution
Variable(s): - o .
1 O' Please provide your st... = Statistics... Std. deviation Minimum Skewness
1 ‘_.? " N [ @] Do you speak a Iangua... Variance Maximum Kurtosis
@5 If you checked "yes", p... Charts... R -

&b If you checked "yes", p...
iy " " ? Cancel Continue
@> If you checked "yes", p... @ Format...

1 & If you checked "yes", p... ('Y

1 &4 If you checked "yes", p... Style...

@ il % How likely are you to g...

&4 What is your current G... Bootstrap...

@5 What is your current G... Cha rtS

Display frequency tables Create APA style tables

® 0 Frequencies: Charts
? Reset Paste Cancel L OK Chart Type L
| Statistics...
@a Please prowd‘ None
@
T T T T T LS If you checkec Charts...

@5 If you checkec © Bar charts
& If you checkec Pie charts Format...
& If you checkec s s
&4 If you checkec e ’ Style...
&4 What is your ¢ Show normal curve on histogram Bootstrap...

&) What is your ¢
£ Do von intent | Chart Values

7) Display freq o Frequencies Percentages

? ? Cancel | Continue OK




Our results:

. Charts
Statistics Bar Chart

Do you speak a language other than English?

= Frequencies
4
Statistics
3
Do you B‘
speak a How likely E
language are you to go =
other than to college? =» g ?
English? (Mark one.) <
('8
N Valid 5 5 1
Missing 0 0
Mean .8000 4.4000 0
Mode 1.00 4.00 No Yes
Do you speak a language other than English?
Frequency Table
Do you speak a language other than English? How likely are you to go to college? (Mark one.)
Cumulative 3
Frequency  Percent  Valid Percent Percent
valid No 1 20.0 20.0 20.0
Yes 4 80.0 80.0 100.0 Ll
Total 5 100.0 100.0 S
=
o
g
How likely are you to go to college? (Mark one.) el
Cumulative
Frequency = Percent  Valid Percent Percent
Valid  Likely 3 60.0 60.0 60.0 0
Extremely likely 2 40.0 40.0 100.0 Likely Extremely likely
o] SH|BT00°0 1000 How likely are you to go to college? (Mark one.)

* How many participants speak a language other than English?

*  80% of the participants in our sample speak a language other than English (N=5)
* How much of the sample is Extremely likely to go to college?

* 40% of the participants in our sample are Extremely likely to go to college (N=5)




Answering our questions: Descriptives

—%& e AR PPRETRC (Al [ HO\

:‘E e Descriptives: Options

LEISts)

 What is the average GPA of our sample?

Mean Sum
Q3. Dispersion Fr ™
1 Std. deviation Minimum
| tions...
@ Doyous Variance Maximum &
i G: If youlSy Range S.E. mean Style...
Same path as Frequencies | & IFyou ch =
q'.. If you ch¢ _pictribution otstrap...
| |Sifyouch Kurtosis Skewness
Analyze > Descriptive Statistics > Descriptives e
oy Display Order
© variable list
Save sta AIphabetic

Ascending means
? e oK

Descending means

? Cancel  (JiCHiRUSH

LSS 4 YarTarIe vy




Our results:

= Descriptives

Descriptive Statistics « What is the average GPA of our sample?
. i Vo y S « The average GPA of our sample was
Inimum aximum ean eviation
What is your current 5 3 4 3.22 313 322 (N=5, SD=313)
GPA for this semester? -
Text

Valid N (listwise) 5




THE END ©

DON'T BE MEAN

30 20 -10 K 10 20 30

BE ABOVE AVERAGE




